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Mise en œuvre
Merci d’avoir choisi le pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII ! Le logiciel 
Line 6 FBV Control a été conçu pour tourner sous Mac® ou sous Windows® et il vous permet de créer 
et de personnaliser les fonctions et possibilités de gestion USB MIDI de votre pédalier FBV™ MkII. 
Ce document vous indique les éléments de base sur le téléchargement, l’installation et la configuration 
du logiciel Line 6 FBV Control sur votre ordinateur Mac® ou Windows®. Commençons.

Ce Guide d’utilisation élémentaire a été conçu pour vous permettre de commencer sans attendre. Pour de 
plus amples détails sur l’utilisation de votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI, ou 
sur son utilisation avec un POD X3 ou un ampli Spider IV, consultez L’aide en ligne sur les pédaliers FBV 
MkII et téléchargez les Modes d’emploi complets des pédaliers FBV MkII et du Spider IV !

Systèmes requis

Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV Control, pour obtenir la 
description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité 
avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté 
d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier FBV MkII.

Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants :

•	 Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits

•	 Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits

•	 Windows® 7 Home ou Professional, en version 32 et 64 bits

•	 Mac OS® X 10.4.11 (Tiger®) 

•	 Mac OS® X 10.5.x (Leopard®)

•	 Mac OS® X 10.6.x (Snow Leopard®) 

Remarque pour les utilisateurs de  Windows Vista® ou Windows® 7: Il est déconseillé de quitter Windows® 
par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à votre 
port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme 
FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. 

Compatibilité logicielle Line 6

L’application autonome POD Farm™ 2, le Plug-In POD Farm™ 2, et GearBox™ 3.7 en version 
autonome sont tous contrôlables par MIDI, pour la majorité de leurs paramètres  - et votre pédalier 
FBV MkII est parfait pour cette tâche ! Téléchargez les dernières versions de POD Farm 2, GearBox 
(version 3.7 ou plus récente nécessaire), ainsi que les dernières mises à jour de votre processeur USB 
audio Line 6 et de votre pédalier FBV MkII. Vous pouvez utiliser Line 6 Monkey, ou aller directement 
à la page des téléchargements Page de téléchargement des logiciels Line 6 pour obtenir les dernières 
mises à jour.

http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/support/
http://line6.com/support/
http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/software/
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Installeur du logiciel Line 6 FBV Control

Si vous n’avez pas encore installé le logiciel Line 6 FBV Control téléchargez l’installeur gratuit pour 
Mac® ou Windows®. Utilisez Line 6 Monkey™, ou allez à la Page de téléchargement des logiciels Line 
6.

Pour plus d’infos sur Line 6 Monkey, consultez «Line 6 Monkey et autres ressources» en page 4•1.

Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur...

Connectez le périphérique Line 6 FBV MkII au port USB de votre ordinateur Mac® ou Windows® et 
lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control 
(ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans 
la page Updates de Line 6 Monkey et suivez les indications de téléchargement et de lancement de 
l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. 

Si l’utilitaire  Line 6 Monkey n’est pas installé sur votre ordinateur...

Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le 
site www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, 
“Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® 
dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.

L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas 
besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour 
votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou Windows® 
pour que celui-ci le détecte comme nouveau périphérique USB. 

Remarque pour les utilisateurs de Windows® XP : Il se peut que Windows® XP identifie votre pédalier 
FBV MkII comme un “périphérique audio USB”. Ceci est normal et causé par le pilote USB de Windows®. 
Pas de problème — votre pédalier FBV fonctionne parfaitement comme périphérique USB MIDI !

Pour désinstaller le logiciel Line 6 FBV

Si vous devez désinstaller l’application, procédez comme suit :

•	 Mac® - Ouvrez le Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application 
Line 6 FBV Control dans la corbeille pour la supprimer. 

•	 Windows® - Allez dans Démarrer > Programes > Line 6 > Tools et sélectionnez l’utilitaire Line 
6 Uninstaller. Cette application très pratique vous permet de supprimer quelques applications et 
pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon.

Connectez votre pédalier FBV MkII

La première fois que vous connectez votre pédalier FBV Shortboard/Express MkII au port USB de 
votre ordinateur Mac® ou Windows®, le système d’exploitation a besoin d’installer un pilote pour 
que le pédalier FBV fonctionne avec les autres périphériques et logiciels de votre ordinateur. Sur les 
ordinateurs Mac®, Windows Vista® ou Windows® 7 ce processus est automatique, et vous pouvez 
passer à la section suivante et utiliser votre pédalier FBV.

http://line6.com/software/
http://line6.com/software/
http://line6.com/software/
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Avec Windows® XP, vous devez suivre les indications de quelques fenêtres pour installer le pilote. 
Une fois que vous avez connecté le câble USB, Windows® XP devrait détecter le nouveau périphérique 
en bas à droite de l’écran :

Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” 
(Non, pas cette fois), puis cliquez sur Suivant (Next).

Dans la fenêtre suivante, sélectionnez “Installer automatiquement” et cliquez sur Suivant. 

Notez que Windows® XP détecte le FBV 
MkII comme un “Périphérique audio 
USB”. C’est normal de la part du pilote 
USB universel de Windows®.

Vous devriez ensuite voir la fenêtre suivante vous indiquer que l’installation est terminée - cliquez sur 
Terminer. Votre FBV est prêt !
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Contrôle total

Connectez votre pédalier FBV MkII au port USB de votre ordinateur, lancez l’application FBV Control. 
Vous pouvez la lancer depuis le raccourci à l’écran ou directement depuis :

•	 Mac® - Applications > Line 6 > Line 6 FBV Control

•	 Windows® - Démarrer> Programes > Line 6 > FBV > Line 6 FBV Control

Une fois l’application ouverte, la fenêtre suivante s’affiche :

Cette fenêtre est importante pour l’utilisation de votre pédalier FBV ! Votre pédalier FBV MkII 
sauvegarde en permanence un Preset FBV dans sa mémoire interne, et cette mémoire interne est 
automatiquement mise à jour lorsque vous éditez n’importe quel réglage dans le logiciel Line 6 FBV 
Control (lorsque le pédalier est connecté, bien sûr...). Ceci facilite la modification des paramètres du 
pédalier FBV MkII. Vous pouvez également sauvegarder les réglages du Preset courant, et créer autant 
de Presets de réglage de votre pédalier FBV que vous le souhaitez, et les sauvegarder sur votre disque 
dur. Consultez la section «Ouverture et sauvegarde des Presets FBV» en page 2•5 pour de plus amples 
détails. Cliquez sur OK pour continuer.

Le logiciel FBV Control charge automatiquement le Preset FBV depuis la mémoire interne du pédalier 
FBV Shortboard ou Expresd MkII connecté. Les affectations de contrôle qui constituent ce Preset 
s’affichent dans l’interface du logiciel. Le pédalier FBV MkII fonctionne comme un périphérique USB 
- MIDI externe conventionnel et communique en tant que tel avec n’importe quel logiciel tournant 
sur l’ordinateur et répondant aux messages de contrôle MIDI (message de contrôleurs continus (CC) 
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MIDI, messages de changement de programme et de banque, messages de gestion machine (MMC)ou 
messages de contrôle Mackie). Pas besoin de connaître tous les détails de la norme MIDI — commencez 
avec les réglages actuels de votre pédalier FBV, ou chargez un Preset FBV... Lisez ce qui suit.

Presets FBV

Votre pédalier FBV MkII est fourni avec des affectation de contrôles MIDI, et vous pouvez voir ces 
réglages se charger dans le logiciel FBV Control (liste Control Properties) lors de son lancement. 
Vous pouvez contrôler votre logiciel avec ces réglages, ou sélectionner l’un des Presets FBV fournis. 
Les Presets FBV regroupent les “affectations de contrôleurs” de votre pédalier FBV Shortboard™ ou 
Express™ MkII. Vous pouvez affecter une fonction MIDI à chaque contrôle du pédalier. Sélectionnez 
File > Open dans l’application FBV Control et sélectionnez un Preset FBV (.fbv). Voici où trouver ces 
Presets :

•	 Mac®  - Documents > Line 6 > FBV > Presets

•	 Windows®  - Mes Documents > Line 6 > FBV > Presets 

Le Preset “FBV-Default.fbv” que vous pouvez voir dans le dossier regroupe les affectations MIDI de 
votre pédalier dans l’état où elles sont lors de la livraison du pédalier FBV. Par conséquent, si vous 
souhaitez revenir aux affectations MIDI initiales de votre pédalier FBV, chargez ce Preset.

Lorsque vous lancez le logiciel à contrôler, allez dans la section des options ou des préférences de 
cette application et sélectionnez le port de sortie Line 6 FBV MIDI Out correspondant au port de 
transmission des données du contrôleur MIDI. Par exemple, dans POD Farm 2 en version autonome, 
allez dans le menu Preferences > MIDI et sélectionnez le port de sortie MIDI FBV MkII souhaité 
comme option d’entrée “MIDI Input” de POD Farm 2.

La plupart des applications MIDI et audionumériques utilisent les commandes MIDI transmises par 
votre pédalier FBV et utilisées par l’application FBV Control. Ceci dit, la plupart des applications 
configurent leurs propres affectations MIDI pour accéder à leurs paramètres, banques et programmes. 
Consultez la documentation de votre logiciel MIDI/audionumérique pour trouver les paramètres de 
contrôle MIDI. Le chapitre «Utilisation du pédalier FBV avec un logiciel» en page 3•1 vous offre plus 
d’astuces sur la configuration de votre pédalier FBV pour contrôler des logiciels MIDI ou d’enregistrement 
audionumérique. 

Passez au chapitre suivant pour en savoir plus sur l’interface utilisateur et les fonctions de l’application 
Line 6 FBV Control. Pour obtenir de plus amples détails, téléchargez le Mode d’emploi avancé du FBV 
MkII et les autres documentations sur la page D’aide en ligne FBV MkII.

http://line6.com/dispatch/?appid=2097217558&page=manuals
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Line 6 FBV Control — Généralités
Le chapitre précédent Mise en œuvre devrait vous avoir aidé à commencer à utiliser votre pédalier 
FBV™ MkII avec le logiciel. Dans ce chapitre, nous vous donnerons une vue d’ensemble des 
caractéristiques et fonctions de l’interface utilisateur de l’application Line 6 FBV Control. 

Quels sont les avantages ? 

Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable 
de contrôler non seulement les amplis Line 6 et les processeurs POD® (par connexion RJ-45), mais 
également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle 
MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais 
puissantes pour vous aider à créer et à personnaliser les types de messages MIDI transmis à votre logiciel 
par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur 
votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout 
moment. Allez-y et modifiez tous les réglages que vous souhaitez et utilisez votre pédalier FBV™ MkII 
pour contrôler toutes les fonctions MIDI de votre logiciel !

Interface graphique utilisateur

La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici 
comment nous avons organisé la description des éléments importants que vous devez connaître pour 
utiliser le logiciel :
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Contrôleurs

1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation 
MIDI de tous les contrôleurs de votre pédalier, cliquez directement sur la représentation graphique du 
contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez 
la Liste Control Properties pour obtenir la description des options d’édition.

Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne le pédalier FBV USB connecté 
(Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier 
FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les Préférences.

2 - Contacteurs au pied : Cliquez directement sur n’importe quel contacteur pour le sélectionner ainsi 
que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation 
MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type 
de réglage MIDI disponible dans la liste Control Properties, quel que soit le nom du contacteur sur le 
pédalier FBV. La Led au-dessus de chaque contacteur du FBV s’allume lorsque vous appuyez dessus pour 
indiquer que la commande MIDI est transmise. Lorsque l’option de contact (Switch Mode) est réglée 
sur “Toggle”, la Led s’allume puis s’éteint, correspondant aux deux états du contacteur transmis lors de 
la pression (contact ouvert ou fermé). 

Remarque : L’état des Leds varie avec l’état des contacteurs (configurés dans la liste Control Properties). 
Le pédalier FBV MkII ne répond pas aux messages MIDI transmis par votre logiciel MIDI ou par votre 
application audionumérique.

3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre 
pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement 
sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau Control Properties). 
Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe 
quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant 
la pédale complètement sur la pointe et en activant le contacteur de fin de course avant. Consultez 
également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH 
est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours 
d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est utilisée. 

4 - Contacteur de fin de course de la Pédale 1 : Cliquez pour sélectionner le contacteur de fin de course 
“Toe Switch” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions :

•	 Ce contacteur peut être assigné à n’importe quelle commande MIDI, comme les autres contacteurs 
du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale.  

•	 De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon 
la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV 
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, 
quelles que soient les options Toe Switch de la liste Control Properties.

Consultez le chapitre “3 - Pédales Wah et Vol” sur les réglages de pédale.

5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase 
Jack “Expression Pedal” à l’arrière pour la connexion d’une pédale d’expression optionnelle (Line 6 
EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la 
zone Pedal 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer 
la Pédale 2 pour transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou 
gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier.
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6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités 
sur votre pédalier FBV Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 
cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez 
cliquer sur n’importe quelle rangée de la liste Control Properties List pour le sélectionner et éditer ses 
paramètres MIDI. Voici la description de chaque colonne et des options offertes...

•	 Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. 

•	 MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les 
commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal 
Vol, et Pedal 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les 
options non-assignées) :

•	 Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur.

•	 Bank Change : Valeur utilisée pour faire défiler les banques de Preset.

Remarque : Les commandes de changement de banque FBV transmettent également un message de Program 
Change dans le message MIDI. Ceci permet de charger automatiquement le premier Preset lorsque vous 
chargez la banque sélectionnée. Par exemple, si votre logiciel est sur la Banque n° 1 et le Preset n° 23, et 
si le logiciel FBV Control est configuré pour envoyer un message de Bank Change, avec Incrémentation, 
Valeur 1, il en résulte le chargement de la Banque 2 et du Preset n° 1 dans votre application cible. 

•	 Program Change : Valeur pour sélectionner un Preset dans la banque.

•	 Contrôleurs Continus MIDI (MIDI CC) : Valeurs et plages de valeurs utilisées par les 
logiciels et équipements MIDI pour accéder aux paramètres. 

•	 MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et 
des fonctions mécaniques (Play, Stop, Record, etc.).

•	 Mackie : Commandes au format “Mackie Universal Controller”, utilisées pour la gestion 
des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les 
logiciels MIDI compatibles avec le format Mackie Control.

Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces 
options varient avec le type de commande MIDI sélectionnée (voir ci-dessus).

•	 Si la commande MIDI est de type Bank Change ou Program Change, avec Increment ou 
Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner 
une valeur de 1 à 10* pour le défilement des Banques/Presets à chaque clic.

*Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes de banque ou de Program 
Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est 
pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI.

•	 Si la commande  MIDI est de type Bank Change ou Program Change, avec une valeur Fixed 
sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 
à 127 pour passer directement à la Banque/Preset correspondant à la valeur.

•	 Si la commande  MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou 
Custom. Si vous sélectionnez Custom, les options Toggle 1/Up et Toggle 2/Down de la rangée 
sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre 
de CC MIDI.
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•	 Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/
Stop, Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind.

•	 Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/
Stop, Record Punch, Pause, Fast Forward, ou Rewind.

Colonnes Toggle1/Up Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande 
MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies 
manuellement pour définir la réaction des options de contacteurs Toggle 1/Up et Toggle 2/Down. 

Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII 
offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur 
votre ordinateur (pour la réception des données MIDI transmises par le pédalier FBV). Vous pouvez 
sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle.

Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner 
n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports, la 
valeur de canal MIDI courant est utilisée pour les quatre ports MIDI (pour modifier le numéro de canal, 
cliquez directement sur la valeur et tirez vers le haut ou vers le bas, ou utilisez la molette de la souris).

Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option  
Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou Pédale 2).

•	 Si le paramètre MIDI Command est réglé sur Bank Change ou Program Change, les options 
disponibles sont Increment, Decrement, ou Fixed :

•	 Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une 
valeur de 1 à 127*, selon la valeur de la colonne Value. 

•	 Decrement : Configure le contacteur pour décrémenter les Banques/Programmes d’une 
valeur de 1 à 127*, selon la valeur de la colonne Value. 

*Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program 
Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas 
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI.

•	 Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/
Programme de 0 à 127, selon la valeur de la colonne Value.

•	 Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle.

•	 Si la commande MIDI est de type MMC ou Mackie, il n’y a pas d’option Switch Mode.

ASTUCE pour le FBV Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous 
déplacez une pédale, l’écran LCD du FBV affiche un texte indiquant le message MIDI transmis (CH 1 CC 
63 VAL 127 indique un message sur le canal MIDI 1, CC MIDI 63, avec une valeur de CC de 127).  

7 - No Line 6 Device Connected : Si aucun pédalier  FBV MkII n’est détecté lorsque vous lancez 
l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à 
l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier:

ASTUCE : Reliez le pédalier avec un câble USB connecté directement à un port USB de l’ordinateur — 
évitez tout Hub (concentrateur) pour obtenir les meilleurs résultats.
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Ouverture et sauvegarde des Presets FBV

L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme 
d’un Preset FBV sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez 
sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, 
ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous 
pouvez ensuite chargez le Preset que vous souhaitez dans le mémoire de votre pédalier FBV. Nous vous 
fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV.

Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, 
l’application FBV Control se lance avec le pédalier correspondant déjà sélectionné — le contenu 
de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. 
De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont 
automatiquement transférées dans la mémoire interne du pédalier FBV MkII (votre pédalier FBV 
MkII contient en mémoire un fichier .fbv complet à la fois).

ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est 
conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre 
ordinateur une fois que vous avez terminé l’édition dans FBV Control. Ceci vous permet de conserver un 
“Backup” de ces réglages dans un fichier .fbv !

Ouverture d’un Preset FBV

•	 Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, 
lancez FBV Control.

•	 Allez dans File > Open.

•	 Par défaut, vous devriez accéder aux répertoires suivants : 

•	 Mac® - Documents/Line 6/FBV/Presets

•	 Windows® - Mes Documents\Line 6\FBV\Presets

•	 Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default.
fbv”). 

•	 C’est également le dossier par défaut de sauvegarde de vos propres Presets .fbv.

•	 Ouvrez l’un de ces Presets .fbv pour charger toutes les affectations de contrôleurs dans l’application 
FBV Control et charger automatiquement la totalité du Preset dans la mémoire interne de votre 
pédalier FBV MkII.

Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque 
vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les 
affectations de contrôleurs USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau 
fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant 
sur votre ordinateur pour pouvoir recharger les réglages plus tard.
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Sauvegarde d’un Preset FBV

Lorsque vous travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages 
courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre 
ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder 
souvent !).

Procédures standard de sauvegarde sous Mac® et Windows®... 

•	 Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par 
les nouveaux, sélectionnez File > Save.

•	 Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau fichier 
FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous 
souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez-
les dans le dossier où sont installés les Presets d’usine lors de l’installation :

•	 Mac® - Documents/Line 6/FBV/Presets

•	 Windows® - Mes Documents\Line 6\FBV\Presets

ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon 
Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé.

Édition et sauvegarde des Presets FBV sans pédalier FBV connecté

Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour 
utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours 
procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save) ou sauvegarder sous (Save 
As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez faire des éditions 
à vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger 
ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez connecter le FBV au port 
USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire 
du pédalier FBV.

Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à 
l’application le type de pédalier à charger à l’écran (Shortboard ou Express MkII). Ceci nous permet de 
faire une transition parfaite vers le chapitre suivant sur les préférences de l’application !

Préférences

Comme c’est le cas avec la plupart des applications, nous avons placé les réglages généraux dans les 
préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : 

•	 Mac® - Line 6 FBV Control > Preferences 

•	 Windows® - File > Preferences
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Sélection du pédalier FBV hors liaison USB

Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV 
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, 
le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le 
pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la 
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez.

Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV 
MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous 
avez plusieurs pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un 
Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous 
souhaitez travailler.

Case Show Warning Dialog at Startup

Cette case vous demande si vous souhaitez voir la fenêtre de mise en garde lors du lancement du 
logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet 
immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). 
Si vous ne souhaitez pas voir la mise en garde, veillez à ne pas sélectionner cette case dans le menu 
Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en 
garde, allez dans le menu Preferences et cochez cette case. Lisez le message avant de désactiver cette 
option, promis ?
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Utilisation du pédalier FBV avec un logiciel

Avec les informations des chapitres précédents, vous devriez être prêt à utiliser votre pédalier FBV 
Shortboard™ MkII ou FBV Express™ MkII pour contrôler votre application logicielle préférée! Voici 
quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre 
pédalier FBV™ MkII.

À propos des ports et canaux USB MIDI

Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII 
établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne 
sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique 
ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Vous pourrez accéder à ces ports MIDI 
FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec 
les communications MIDI.

*Notez que les noms de ports USB MIDI In et MIDI Out sont différents dans votre application MIDI selon 
le système d’exploitation de votre ordinateur - Consultez l’exemple d’Ableton Live® ci-dessous.

Configurer votre logiciel pour les communications du port MIDI du FBV MkII

Il vous suffit de configurer l’application logicielle pour qu’elle reçoive les commandes MIDI du pédalier 
FBV en provenance du port MIDI Out et du canal MIDI sur lesquels est configuré le pédalier. Par 
exemple, avec Ableton Live® ou Live Lite®, le menu Preferences > MIDI/Sync offre des options de 
sélection d’un ou plusieurs contrôleurs MIDI. Dans le logiciel MIDI/audionumérique, vous pouvez voir 
les ports FBV MIDI 1 à 4 par lesquels les données de contrôle MIDI sont reçues.

Remarque : Le nom exact des quatre ports varie sous Mac OS® X, Windows® — Consultez l’exemple 
suivant avec GearBox™.

Par défaut, toutes les affectations du pédalier sont transmises au pédalier FBV par le port FBV MIDI 
Out 1. Ceci dit, vous pouvez utiliser n’importe quel port FBV MIDI Out 1 - 4 (voir la Liste Control 
Properties page 2•3).

Communication avec les Ports MIDI Windows®

Il est important de noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV 
MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la 
fois d’utiliser plusieurs  ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, 
utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par 
conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre 
ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est 
autorisée à communiquer. 

Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de 
lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est 
déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In 
et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser 
l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour 
commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez 
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toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez 
les ports MIDI pour son fonctionnement.

Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à 
jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et toute application MIDI/
audionumérique avant de lancer Line 6 Monkey.

Canaux MIDI

Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision 
— votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez 
la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données 
MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque 
contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI 
(consultez la Liste Control Properties page 2•3). Il se peut que votre logiciel vous offre des options de 
réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Dans ce cas, veillez à 
configurer les options de canal MIDI pour qu’elles correspondent aux données transmises par le pédalier 
FBV. Consultez la documentation de votre logiciel pour obtenir de plus amples renseignements sur la 
configuration des canaux MIDI.

Contrôle de l’application autonome Line 6 POD Farm™ 2

Si vous possédez la licence POD Farm 2 pour votre processeur Line 6 POD Studio™, TonePort™ ou 
GuitarPort™, vous pouvez utiliser le pédalier FBV MkII comme contrôleur MIDI de n’importe quelle 
fonction de POD Farm 2 en version autonome ! 

Remarque : L’application autonome POD Farm 2 nécessite l’utilisation d’un processeur Line 6 POD Studio, 
TonePort ou GuitarPort. Le Plug-In POD Farm 2 peut être acheté sous forme de licence supplémentaire 
pour le POD X3 Line 6, le PODxt et sous forme de clef iLok USB - consultez la section suivante sur le 
contrôle du Plug-In POD Farm 2.

Configuration de l’entrée MIDI

Vous devez tout d’abord configurer l’application autonome POD Farm 2 pour recevoir les communications 
MIDI du pédalier FBV MkII connecté. Veillez à connecter le FBV MkII à l’ordinateur avant de lancer 
POD Farm 2, puis procédez comme suit : 

•	 Lancez le menu Preferences de POD Farm 2 et allez dans l’onglet MIDI. Vous pouvez alors 
sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les quatre ports de 
sorties MIDI sont nommés différemment selon le système d’exploitation de votre ordinateur :

Menu Preferences - MIDI sous Mac OS® X
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Menu Preferences - MIDI sous Windows® 7 ou Windows Vista® 

Menu Preferences - MIDI sous Windows® XP

•	 Par défaut pour commencer, tous les ports MIDI de tous les périphériques Line 6 sont sélectionnés. 
Vous ne gardez que ceux dont vous avez besoin. Les réglages sont mémorisés et sont utilisés par 
l’application POD Farm 2.

•	 Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les données MIDI 
uniquement du Port 1 du pédalier FBV Shortboard MkII connecté (notez que le périphérique 
Line 6 UX2 connecté est aussi une option, étant donné que les contacteurs au pied 1 & 2 sont 
configurés pour transmettre les données MIDI).

Pour l’étape suivante, configurez votre FBV MkII pour transmettre les commandes MIDI nécessaires 
pour accéder aux fonctions de POD Farm 2. Pour vous faciliter les choses, nous avons créé les Presets 
“POD Farm 2” FBV control (.fbv file) que vous pouvez charger. Ces Presets sont disponibles en 
téléchargement sur le site de  l’aide en ligne Aide en ligne de POD Farm. 

•	 Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. 

•	 Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”.  

Une fois que vous avez téléchargé le Preset FBV Control pour votre périphérique, utilisez l’application 
FBV Control Line 6 pour charger le Preset dans la mémoire interne du FBV MkII (sauvegardez ce 
Preset avec vos autres Presets FBV Control, pour les retrouver plus facilement !).

Control total

Une fois le POD Farm 2 configuré pour recevoir les données MIDI de votre FBV MkII, et une fois le 
FBV MkII chargé avec les commandes MIDI du POD Farm 2, vous êtes prêt à prendre le contrôle de la 
majorité des paramètres de POD Farm 2 ! Les réglages du Preset POD Farm 2 pour FBV Control vous 
permettent d’accéder instantanément à des affectations MIDI “pré-configurées” qui existent déjà dans 
POD Farm 2. Les réglages de banque MIDI et de Program Change sont également dans le Preset POD 
Farm 2- FBV Control de sorte que les contacteurs au pied vous permettent de naviguer dans les listes 
et les Presets de sons de POD Farm 2. 

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
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Il est également possible de personnaliser vos options de contrôle MIDI avec l’utilisation de la fonction 
d’apprentissage automatique “MIDI Learn” de POD Farm 2, et de créer vos propres affectations MIDI 
à l’intérieur de POD Farm 2. Tous les paramètres de POD Farm 2 offrant l’apprentissage MIDI Learn 
“apprennent” les commandes de type Contrôleur Continu MIDI (CC), de Note On et de molette de 
hauteur. Par conséquent, vous devez configurer ce type de commandes en fonction des contrôleurs 
individuels du FBV MkII à l’aide du logiciel FBV Control. Notez également que la plupart des paramètres 
de commutation “On/Off” de POD Farm 2 nécessitent que vous régliez le mode de commutation des 
CC MIDI sur “Toggle” (pour activer/désactiver le paramètre) ou sur “Momentary” (le paramètre est 
actif uniquement lorsque vous appuyez sur le contacteur au pied).  

Pour obtenir de plus amples détails sur ces fonctions de contrôle du POD Farm 2 par MIDI, consultez 
le Mode d’emploi détaillé du pédalier FBV MkII et le Guide d’utilisation élémentaire de POD 
Farm 2, disponibles sur le site de l’aide en ligne Aide en ligne de POD Farm.

Contrôle du Plug-In POD Farm 2 Line 6

Comme avec l’application autonome POD Farm 2, vous pouvez utiliser le pédalier FBV MkII comme 
contrôleur MIDI externe et modifier à distance les paramètres du Plug-In POD Farm 2 ! Vous devrez 
configurer l’application audionumérique hôte pour recevoir les données MIDI du FBV MkII et les 
affecter à la piste audio où est inséré le Plug-In POD Farm 2. Il vous suffit de configurer l’entrée d’une 
piste MIDI pour qu’elle reçoive les données du port FBV MkII, de relier la sortie de la piste MIDI à 
la piste audio et au Plug-In, et d’armer la piste pour qu’elle reçoive le MIDI. Consultez l’aide de votre 
application audionumérique hôte pour configurer ces options d’entrée MIDI - nous avons également 
ajouté certains tutoriels pour le routage MIDI de ce type d’application audionumérique dans le Mode 
d’emploi détaillé de POD Farm 2 et le Guide de configuration pour l’enregistrement de POD Farm 
2.

Une fois que vous avez configuré l’application hôte pour qu’elle dirige la sortie MIDI vers le Plug-
In POD Farm 2, les réglages du Preset POD Farm 2 - FBV Control vous permettent d’accéder aux 
affectations des contrôles MIDI “pré-configurés” de POD Farm 2. Les réglages de banque MIDI et de 
Program Change sont également dans le Preset POD Farm 2- FBV Control de sorte que les contacteurs 
au pied vous permettent de naviguer dans les listes et les Presets de sons de POD Farm 2.

De même, comme nous l’avons vu dans la section précédente sur POD Farm 2 en version autonome, 
vous pouvez personnaliser les possibilités de contrôle en utilisant la fonction d’apprentissage MIDI 
automatique de POD Farm 2 et affecter les pédales et contacteurs au pied de votre pédalier FBV MkII 
aux paramètres souhaités de POD Farm 2.

Remarque : Les Plug-Ins POD Farm Elements fournis avec POD Farm 2 ne possèdent pas d’entrée MIDI 
et ne peuvent pas être contrôlés par MIDI. Ceci dit, la plupart des applications audionumériques hôte 
permettent une gestion interne du MIDI pour la plupart des paramètres de pistes, et permettent en général 
la gestion par MIDI des Plug-Ins. Consultez l’aide de votre application audionumérique pour utiliser 
votre pédalier FBV MkII pour contrôler ces paramètres. Consultez également le chapitre «Contrôle 
d’applications MIDI/audionumériques» en page 3•6.

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554


Logiciel Line 6 FBV Control : Utilisation du pédalier FBV avec un logiciel

3•5

Gestion du logiciel Line 6 GearBox

Si vous utilisez GearBox, vous serez heureux de savoir que la plupart des paramètres d’amplis et d’effets 
du logiciel peuvent être commandés par messages MIDI transmis par un contrôleur MIDI externe. Cela 
signifie que vous pouvez le contrôler avec votre pédalier FBV MkII ! 

Remarque : Il est conseillé de vous procurer la version 3.7 de GearBox (ou plus récente) pour utiliser votre 
pédalier FBV MkII. À cette fin, lancez Line 6 Monkey avec votre processeur USB audio Line 6 connecté 
(POD Studio, TonePort, GuitarPort, POD® X3, POD®xt) et laissez Monkey vous guider dans les mises 
à jour à effectuer.

Afin de configurer GearBox pour recevoir les messages de contrôle MIDI du pédalier FBV MkII, allez 
dans GearBox Preferences > MIDI/Control et réglez l’option “MIDI Input” sur la réception du port 
FBV MIDI Out souhaité, comme indiqué ci-dessous. Notez que vous pouvez voir les quatre ports FBV 
MIDI Out nommés différemment, selon le système d’exploitation de votre ordinateur:

Mac OS® X Windows Vista®

Windows® XP

Comme indiqué en page précédente, vous pouvez choisir parmi quatre ports FBV MIDI, alors 
sélectionnez le port MIDI Out utilisé par votre pédalier FBV. Par défaut, c’est le premier port de la 
liste. Vous pouvez vérifier et éditer les affectations de ports MIDI avec le logiciel FBV Control.

Remarque : Dans Windows® XP, les ports MIDI FBV apparaissent sous la forme “Périphérique USB 
Audio”. C’est normal et vient du pilote USB universel de Windows®. Il s’agit en fait des ports FBV USB 
MIDI Out 1 à 4.

GearBox reçoit toujours les données MIDI sur le canal 1 : Réglez les contrôleurs du pédalier FBV pour 
qu’ils transmettent tous sur ce canal MIDI. Comme nous l’avons vu dans le chapitre Mise en œuvre, 
chargez le Preset GearBox FBV dans votre pédalier FBV MkII avec l’application FBV Control dans le 
menu File>Open. Vous disposerez ainsi de contrôles parfaits pour GearBox !

ASTUCE : Pour consulter toutes les affectations de CC MIDI des paramètres de GearBox, téléchargez le 
document de référence des CC MIDI Line 6 sur la page Aide en ligne FBV MkII.

http://line6.com/dispatch/?appid=2097217558&page=manuals
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Contrôle d’applications MIDI/audionumériques

De nos jours, la plupart des logiciels de musique permettent une gestion externe par messages MIDI, 
comme ceux transmis par les pédaliers FBV MkII. Pour commencer, vous devez configurer le logiciel 
pour qu’il reçoive les communications des ports USB MIDI du pédalier FBV MkII connecté (consultez 
le chapitre Ports et canaux USB MIDI). Ensuite, configurez votre pédalier FBV MkII pour qu’il 
transmette les commandes MIDI nécessaires à la gestion des paramètres souhaités de votre application. 
Certaines applications MIDI et audionumériques sont faciles à configurer, alors que d’autres sont plus 
complexes à configurer pour leur gestion par MIDI.

Fonction d’apprentissage MIDI automatique

De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI 
(“MIDI Learn”) : il vous suffit de cliquer sur le bouton/curseur/touche dans l’interface utilisateur de 
l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement 
au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/
pédale du pédalier FBV au paramètre sélectionné. Par exemple, Propellerhead Reason et Ableton Live 
offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de 
pistes, et même pour les synthés virtuels et les effets ! 

Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que le contrôleur sélectionné 
sur le pédalier FBV MkII contrôle bien le paramètre souhaité dans l’application. Assurez-vous que les 
contrôleurs du pédalier FBV MkII possèdent un message de CC MIDI différent à transmettre. Vous 
pouvez régler chaque contrôleur du pédalier FBV MkII pour qu’ils transmettent tous un message de CC 
MIDI différent. Pour configurer ces réglages, vous pouvez bien sûr utiliser les options de la Liste Control 
Properties page 2•3 de l’application FBV Control, ou vous pouvez charger le Preset “FBV- Default.fbv” 
fourni. Consultez le mode d’emploi de votre application MIDI/audionumérique pour obtenir de plus 
amples renseignements sur la configuration des périphériques de gestion MIDI et de l’affectation des 
paramètres.

Affectation manuelle des contrôleurs MIDI

Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus 
manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du 
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà 
affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques 
utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program Change pour les 
changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec 
la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control 
pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres MIDI correspondant 
dans l’application. 

Consultez également le Mode d’emploi avancé des pédaliers MkII et d’autres documents MIDI disponibles 
sur l’Aide en ligne 6 FBV pour obtenir de plus amples renseignements sur la gestion MIDI.

http://line6.com/dispatch/?appid=2097217558&page=manuals
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Line 6 Monkey et autres ressources
Line 6 Monkey™ est l’utilitaire de mise à jour intelligent installé automatiquement avec l’application 
FBV Control. Il est vivement conseillé de lancer Line 6 Monkey après avoir installé le logiciel FBV 
Control, et de le lancer souvent pour vous assurer que vous disposez des dernières mises à jour pour 
tous vos produits logiciels et matériels Line 6. Il est également très important que vous enregistriez vos 
produits Line 6 pour bénéficier de la garantie et pour nous permettre de vous contacter en présence 
de nouvelles versions logicielles ou d‘autres améliorations technologiques disponibles ! N’attendez pas 
plus longtemps. 

Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV™ MkII au port USB de 
votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey 
contrôle votre pédalier FBV). Quittez l’application FBV Control et toutes les autres applications 
MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les 
étapes suivantes pour lancer Line 6 Monkey...

•	 Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey

•	 Sur Windows®, allez dans le bouton Démarrer > Programmes > Line 6 > Tools > Line 6 Monkey

Compte enregistré

Vous devez vous créer un compte personnel pour que Line 6 Monkey puisse communiquer avec le 
serveur en ligne de Line 6 et vous offrir exactement ce dont vous avez besoin. Cela ne prend que 
quelques clics de souris et c’est gratuit !

•	 Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe 
(Password) en haut de la fenêtre de Monkey. 

•	 Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et 
suivez les étapes à l’écran.

Enregistrez votre pédalier

Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer (Register) le produit Line 6 
connecté. Il se peut que vous ayez à enregistrer votre pédalier FBV MkII pour pouvoir activer le produit 
ou pour réaliser certaines mises à jour. C’est très simple, alors cliquez sur le bouton Register Now et 
remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés.



Logiciel Line 6 FBV Control : Line 6 Monkey et autres ressources

4•2

Téléchargez les mises à jour

Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans 
la page des mises à jour (Updates) de Line 6 Monkey, si vous voyez un élément avec une nouvelle 
version disponible, cliquez dessus et laissez le petit singe vous aider à l’installer. C’est la façon la plus 
simple d’être assuré d’utiliser les dernières mises à jour logicielles et matérielles Line 6. 

Mise à jour de la mémoire Flash

Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour 
bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les 
étapes indiquées par Monkey, et notamment les points suivants : 

•	 Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier.

•	 Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les 
câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. 

•	 Lorsque Line 6 Monkey vous indique que la mise à jour est terminée, quittez Line 6 Monkey et 
lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. 

Autres ressources

À la recherche de plus amples informations ? Cliquez tout simplement...

•	 Documents supplémentaires d’aide sur les derniers produits FBV MkII et références MIDI :  

Aide en ligne du pédalier FBV MkII

•	 Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm™ 2 en version Plug-In 
& autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 
6 :

Aide en ligne de POD Farm

•	 Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page 
d’assistance de Line 6 (Support), ce qui comprend la base de données : 

Assistance Line 6

•	 À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? 
Consultez le site d’achat en ligne de Line 6 !

Site marchand Line 6

http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
http://line6.com/support/
http://www.line6.com/store/storefront.html
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•	 Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : 

•	 Des pistes d’accompagnement MP3 Jam Tracks.

•	 Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore.

•	 Des cours de guitare gratuits avec les Pros des studio de LA.

•	 Des outils de pratique des gammes et accords.

•	 Des informations sur les concours et les offres spéciales.

•	 Des accès aux forums de discussion, aux mises à jour logicielles et plus encore.

Communautés Line 6

http://line6.com/community/
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